Table of Contents

1 Windows 2000/XP/Vista and Windows Server 2003 . . . . . . 1-1
   About the software .......................................................... 1-1
   Bundled software ......................................................... 1-1
      Xerox 4112/4127 PS Driver and PPD files ........................ 1-1
      Adobe Acrobat Reader .................................................. 1-1
   Hardware/software requirements ................................. 1-2
      Computer System ......................................................... 1-2
      Basic Software ........................................................... 1-2
   The Xerox 4112/4127 PS Printer Driver ................................ 1-2
      Installation Procedure .................................................. 1-3
   Device options and print settings ................................... 1-10
      Device Settings tab .................................................... 1-10
      Configuration tab ....................................................... 1-11
      Detailed Settings tab ................................................... 1-13
      Paper/Output tab .......................................................... 1-15
      Layout tab ..................................................................... 1-20

2 Macintosh computers ................................................ 2-1
   About the software .......................................................... 2-1
   Bundled software ........................................................... 2-1
      AdobePS Printer Driver (ver. 8.5.1, 8.7.0, and 8.8) and PPD files 2-1
      Xerox PPD Installer ......................................................... 2-1
      Xerox PS Utility .............................................................. 2-1
      Adobe Screen Fonts ......................................................... 2-1
      ATM (Adobe Type Manager) (ver. 4.5.2) ............................. 2-1
      Adobe Acrobat Reader ..................................................... 2-2
      Readme.txt ...................................................................... 2-2
   Hardware/software requirements ..................................... 2-2
      Computer system ............................................................... 2-2
      Basic software ................................................................. 2-2
   AdobePS Printer Driver .................................................... 2-2
      Installation procedure (Mac OS X) .................................... 2-3
      Adding a Printer (Mac OS X) ............................................ 2-4
      Printer options ................................................................. 2-6
         For Mac OS X ................................................................. 2-6
      Printer features ................................................................. 2-7
         For Mac OS X ................................................................. 2-7
      Job Type (Mac OS X only) ................................................. 2-11
      Job Accounting (Mac OS X only) ........................................ 2-13
   Installing screen fonts ....................................................... 2-15

3 Barcode Settings .......................................................... 3-1
   About barcode settings ................................................... 3-1
   Font types and character sets ........................................ 3-1
   Sample program and output results ................................. 3-2
   Character set tables .......................................................... 3-2
<table>
<thead>
<tr>
<th>Table of Contents</th>
<th>Xerox 4112/4127 Copier/Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAN character set table</td>
<td>3-2</td>
</tr>
<tr>
<td>Code 39 character set table</td>
<td>3-3</td>
</tr>
<tr>
<td>NW7 character set table</td>
<td>3-4</td>
</tr>
<tr>
<td>Code 128 character set table</td>
<td>3-4</td>
</tr>
<tr>
<td>ITF (Interleaved 2 of 5) character set table</td>
<td>3-8</td>
</tr>
<tr>
<td>Example:</td>
<td>3-9</td>
</tr>
<tr>
<td>Customer barcode character set table</td>
<td>3-9</td>
</tr>
<tr>
<td>Barcode sizes</td>
<td>3-10</td>
</tr>
<tr>
<td><strong>A Appendix</strong></td>
<td><strong>A-1</strong></td>
</tr>
<tr>
<td>Cautions and limitations</td>
<td>A-1</td>
</tr>
<tr>
<td>About the driver</td>
<td>A-1</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>A-1</td>
</tr>
<tr>
<td>Print operation</td>
<td>A-1</td>
</tr>
</tbody>
</table>
Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens displayed on your 4112/4127 system. The UI screens vary from system to system and from marketplace to marketplace. Therefore, the UI screens in this guide are a representation of the type of screens that may be seen on your particular system.

About the software

Bundled software

The following items are included on the CD-ROM and are necessary when using the printer on Windows 2000, Windows XP, Windows Vista, and Windows Server 2003. Please read the “Readme.txt” file which contains cautionary notes about how to use the printer driver.

Xerox 4112/4127 PS Driver and PPD files


Adobe Acrobat Reader

Allows you to view and print PDF files on all major computing platforms.
Hardware/software requirements

The minimum system requirements for the printer driver are:

**Computer System**

Personal computer which can run the Windows 2000, Windows XP, Windows Vista, or Windows Server 2003 operating system.

**Basic Software**

- Windows 2000 Professional
- Windows 2000 Server
- Windows 2000 Advanced Server
- Windows XP Professional Edition
- Windows XP Home Edition
- Windows Vista Home Basic/Premium Edition
- Windows Vista Business/Ultimate
- Windows Server 2003

The Xerox 4112/4127 PS Printer Driver

**Tip**

When installing the printer driver, ensure that you select the correct one (4112/4127).


This section describes how to install the printer driver for Windows 2000, as an example.

**Notes**

- It is possible to cancel installation of the printer driver by clicking **Cancel** in the dialog box displayed during installation. You can also click **Back** to delete the settings in that dialog box and return to the previous dialog box.
- If you want to set up Port 9100, refer to the System Administration Guide.
Installation Procedure

1. Start the computer.
   
   Note
   Log on as a Power User group member or an Administrator. Refer to the Windows 2000 documentation for details about the Power User group.

2. On the Start menu, point to Settings and click **Printers**.

3. In the Printers window, double-click **Add Printer**.

4. Click **Next**.

5. Select how the printer is connected to the computer and click **Next**.
   
   Select **Local printer** if the printer is connected directly to the computer or to the network in the TCP/IP(LPD) environment. Otherwise, select **Network printer**. The following is an example of a Local printer.
Notes

- When you select **Local printer**, deselect the “Automatically detect and install my Plug and Play printer” check box.
- Specify the target printer in the Connect to printer dialog box if you selected **Network printer**.

6. Select the port you are using and click **Next**.

When the printer is connected in the TCP/IP(LPD) environment:

a. Click **Create a new port**.

b. Select Standard TCP/IP Port in the Type list and click **Next**.
c. Click **Next**.

![Add Standard TCP/IP Printer Port Wizard](image)

Welcome to the Add Standard TCP/IP Printer Port Wizard.

You use this wizard to add a port for a network printer.

Before continuing, be sure that:
1. The device is turned on.
2. The network is connected and configured.

To continue, click **Next**.

![Add Standard TCP/IP Printer Port Wizard](image)

Add Port

For which device do you want to add a port?

Enter the Printer Name or IP address, and a port name for the desired device.

- **Printer Name or IP Address:**
- **Port Name:**

![Add Standard TCP/IP Printer Port Wizard](image)

< Back | Next > | Cancel

---

d. Enter the IP address of the printer in **Printer Name or IP Address**, then click **Next**.
e. Click **Finish** in the dialog box that will be displayed.


8. Click **Have Disk**.

![Add Printer Wizard dialog box](image)

9. Enter “Drive Name: PrinterDriver\Win2K_XP” in the “Copy manufacturer’s files from:” box and click **OK**.

In this example, we have used “D:” as the CD-ROM drive. If you are using a different drive for the CD-ROM, specify accordingly.
Note
Click **Browse** to specify a folder on the CD-ROM.

10. Select your printer model from the Printers list and click **Next**.

11. Enter the printer name, set whether you want to use it as the default printer, and click **Next**.
12. Select **Do not share this printer** and click **Next**.

We recommend that you install the driver on each computer with the procedure appropriate to the operating system.

![Add Printer Wizard](image)

13. Specify whether or not to print a test page, then click **Next**.

![Add Printer Wizard](image)
14. Click **Finish**.

![Add Printer Wizard]

Completing the Add Printer Wizard

You have successfully completed the Add Printer wizard.

You specified the following printer settings:

- Name: Xerox 4110 PS
- Shared as: Not Shared
- Port: \.\\192.168.1.71\ip1
- Model: Xerox 4110 PS
- Default: Yes
- Test page: No

To close this wizard, click Finish.

---

**Note**

If the dialog box “Digital Signature Not Found” appears, click **Yes** to continue the installation.

Installation begins.

15. Confirm that the printer has been added in the Printers window.

![Printers Window]

- This completes the installation of the printer driver. Remove the CD-ROM from the drive.
- See “Device options and print settings” to configure the printer.
- Store your CD-ROM in a safe place.
Device options and print settings

To view the Device Settings or Configuration tabs, select the printer in the Printers window, then click [Properties] on the File menu.

To view the Advanced Options dialog box, select the printer in the Printers window, then click Printing Preferences on the File menu. Click Advanced in the Layout screen.

To view the Output Settings tab, select the printer in the Printers window, then click Printing Preferences on the File menu.

**Device Settings tab**

This section describes installable options in the Device Settings tab. To print correctly, it is necessary to make the appropriate settings in this tab.

Select the items in Installable Options area and change the settings in the menu that appears on the right.

**Settings:**

**High Capacity Feeder**

Select "Available" if the High Capacity Feeder has been installed.

**Hole Punch**

Specify the number of holes to punch on the paper. Select from "2 Holes/4 Holes" or "2 Holes/3 Holes."

**Tri-Folding Output Tray**
Select "Available" if the Tri-Fold Output Tray is installed.

**Booklet Output Tray**

Select "Available" if the Booklet Tray is installed.

**Paper Size Settings**

Specify the paper size group for different locales to enable the selection of paper sizes common to that locale. The following groups of paper size categorized by locale are available: "AB Series," "AB Series (8K / 16K)," "AB Series (8 x 13 in.)," "AB Series (8 x 13 / 8 x 14 in.)," and "Inch Series." As the paper size settings will be set automatically in accordance with the relevant locale, it is usually not necessary to change this setting.

**Switch Paper Size (8K/16K)**

Indicate your language preference to enable the set of 8K and 16K paper sizes that is best suited to your needs. If you select "Traditional Chinese," the dimensions of the 8K and 16K paper sizes are 267 x 388mm and 194 x 267mm respectively. If you select "Simplified Chinese," the dimensions will be 270 x 390mm and 195 x 270mm respectively.

**Note**

If "AB Series (8K/16K)" is not selected in "Paper Size Settings," both sets of 8K and 16K paper sizes will not be available despite the setting specified here.

**Configuration tab**

![Configuration tab](image)

**Note**

You can restore defaults by clicking **Restore Defaults**.

**Settings:**

**Account Mode**

Specifies if all users or only System Administrators can change authentication related settings.

**Detailed User Settings**
Sets the authentication information.

- **Use Default User Settings** - The values set in this feature are used as the authentication parameters.
- **Specify Job Owner Name** - Select how to specify User ID.
- **Job Owner Name** - Enter a User ID.
- **Password** - Enter a Password that matches the User ID.
- **Account ID** - Enter an Account ID.
- **Billing ID** - Enter a User ID for Charge Print.
- **Password** - Enter a Password that matches the Billing ID.

- **Prompt User for Settings** - Select this feature to display the Enter User Details dialog-box each time you start printing. The user is then required to enter authentication information such as their User ID.
  - **Display Previous User Details** - Select to store the user details entered in the Enter User Details dialog-box, and display the details in the box as a default next time.
  - **Hide User ID(***)** - Select to specify whether an account ID is to be displayed or hidden when it is entered.
  - **Hide Account ID(***)** - Select to specify whether an account ID is to be displayed or hidden when it is entered.

**High Speed Printing**

Set this feature to make improvements in print speed, when using an application that generates PostScript directly.

**Get Information from Printer**

Clicking **Get Information from Printer** when the machine is used as a network printer verifies the printer option installation state using the print port to which the printer is connected, and reflects this in the Hardware Options setting.
Detailed Settings tab

Select the items from Printer Features and change them on the menu displayed to the right.

Settings:

Bypass Feed Orientation

Specifies the paper orientation when printing from the bypass tray. When feeding the short edge of the paper first, select Landscape. When feeding the long edge of the paper, select Portrait.

Offset Stacking

The position of individual jobs or sets of copies are shifted to either side of the output tray to enable easy separation.

Covers

Specifies the settings related to Covers.

Note

The cover cannot be printed.

- **Front Cover** - Specify whether to add a front cover to the printouts. Select the paper tray for feeding the front cover sheets.
- **Back Cover** - Specify whether to add a back cover to the printouts. Select the paper tray for feeding the back cover sheets.
- **Tray 8 - Specify Tab Stock** - Specify whether tab stock is being loaded in tray 8. Select either “Plain” or “Tab Stock.”
Transparencies

Set up separators to be inserted between transparencies.

- **Feed Separators from** - Specifies the paper tray that transparency dividers are to be fed from. When **Auto** is selected, the tray set on the machine is used as the feed destination.

- **Print on Separators** - Specifies whether or not to print on the transparency dividers as well as the transparency.

Images

Set up image-related settings.

- **Print Mode** - Specifies whether to give priority to the print speed or the image quality.

- **Halftone** - Select the halftone settings for printing.
  - Select **Fine Dots** for the small size halftone dot commonly used in PostScript.
  - Select **Thick Dots** for coarser dots than the Fine Dots setting.
  - Select **Type 3** for the same halftone setting that is used in PCL.

- **Image Enhancement** - Specifies whether or not to use the Image Enhancement function. Selecting **On** smooths out boundaries when printing. This reduces jagged edges by artificially increasing the resolution of the image. When printing a bitmapped image composed of coarse halftone dots, smooth color or grayscale gradation is impossible in certain situations. In this case, select **Off**.

Details

Set up other printing options.

- **Image Rotation (180deg)** - Set the checkbox to rotate the prints by 180°. Default is **Off**.

- **Double Print** - Enable this feature to repeatedly print one page twice on a paper with a bigger size than the original. You can use Double Print feature if you have set the zoom ratio to 100% with the following paper size and output size settings.
  - Paper Size
  - Output Size
  - A4
  - A3
  - A5
  - A4
  - B5
  - B4
  - Folio (8.5 x 11 in.)
  - Ledger (11 x 17 in.)

- **Skip Blank Pages** - Specify whether to skip blank pages when printing documents that consist of blank pages.

- **Draft Mode** - Specifies whether or not to reduce the amount of toner used when printing drafts. When **On** is selected, the overall printed page becomes lighter. This is best for printing documents when high print quality is not necessary.

- **Banner Sheet** - Specifies whether or not to add a banner sheet to printed output.
  - When **Use Printer Settings** is selected, the printer settings are used.
When Printer Start Page is selected, outputs the banner sheet using the start-sheet.

- **E-mail Job Confirmation** - Specifies whether or not to use the Mail Notify feature to notify the end of the print job via e-mail. Default is Off.
  
  **Enter Address** - Specifies the e-mail address for the Mail Notify feature.

- **Substitute Tray** - Specifies what action to take when the paper for the print size is not loaded in the machine.

- **Tab Margin Shift** - Selecting On shifts the image by 13 mm during printing on the printer, and prints text on the tab portion of the tab stock. When preparing a document, place text on the part of the document where the tab will be located (assuming that the entire image will be shifted by 13 mm).

  The tab is on the side of the tab stock that is output first.

- **Custom Paper Auto Orientation** - Specifies whether or not to correct the orientation of the custom paper.

- **Print Mixed Size Originals** - Controls the orientation of the second-side image when printing double-sided.

### About

Click the "About" button to display the "About" dialog box. The version number and copyright description for this print driver will be displayed.

### Help

To display Help, click the "Contents" button at the top left of the screen. You can find detailed descriptions on the content items in Help or enter keywords to search for needed information.

### Paper/Output tab

![Xerox 4112/4127 Copier/Printer Windows 2000/XP/Vista and Windows Server 2003 PostScript User Guide](image)

**Note**

You can restore defaults by clicking **Restore Defaults**.
**Settings:**

**Job Type**

You can select Normal Print or specify the print function for Secure Print, Sample Print, and Delayed Print. To use Secure Print, Sample Print, or Delayed Print feature, input the User ID and password for Print Type in the Configuration tab. The password entered appears as asterisks (*).

- **Normal Print** - Select when you do not want to output secure prints, sample prints, or delayed prints.
- **Secure Print** - Secure Print temporarily stores print jobs in the printer and then prints them when print instructions are received from the control panel. Select when you want to output secure prints.
  - **User ID** - Displays the User ID for Job Type. The user ID displayed is the User ID specified on the Configuration tab. This option can only be selected when the setting on the Configuration tab has been completed. This is a display-only item and cannot be changed here.
  - **Password** - Displays the password for Secure Print as specified in the Configuration tab. Each digit entered appears as an asterisk (*). This option can only be selected when the setting on the Configuration tab has been completed. This is a display-only item and cannot be changed here.
  - **Retrieve Document Name** - If Auto Retrieve is selected, the document name will be obtained from the application that sends the print command. No manual entry is allowed. Document names that exceed 24 characters are truncated.
  - **Document Name** - When “Enter Document Name” is selected in the Retrieve Document Name list, a document name up to 24 alphanumeric characters.
- **Sample Print** - Sample Print outputs only one copy when multiple copies are specified. If there is no problem, the remaining sets can be printed. Select when you want to output sample prints.

**Note**
The Collated setting must be selected in the Page Setup tab when using Print Type.

- **Delayed Print** - Delayed Print temporarily stores print jobs in the printer, and then prints them at the scheduled time. Select when you want to output delayed prints.
  - **Start Print Time** - Specifies the time when a Delayed Print job will be printed. Place the cursor in the hour or minute box and press the up or down triangle to specify the start time. You can also set the time by entering the time directly into the boxes. The default setting is 00:00.

**Paper Size**

Select the paper size of the file to be printed.

**Paper Source**

Select the paper tray to be used for printing.

**Paper Type**

Select the paper type to be used for printing.
2-sided Print

Performs 2-sided printing. Select either “Flip on long edge” or “Flip on short edge” for 2-sided printing. Select any one of these options as required. In “Flip on long edge” and “Flip on short edge,” the side 1 and side 2 images are printed such that when rotated with the long edge and short edge respectively as axis, they are pointing in the same direction.

Stapling

Select the stapling position. The stapling position specified is based on the printing data. If the stapling position is incorrect, refer to the PostScript Kit manual and adjust the Stapling setting accordingly.

Note

Limitations for stapling mixed size output may apply. Stapling for mixed size output is not available in the following situations:

- When a setting other than “1 Up” is selected for “Multiple-Up” in the “Layout” tab
- When a setting other than “Off” is selected for “Booklet Creation” in the “Layout” tab
- When “Double Print” is set to “On” under “Details” in the “Detailed Settings” tab
- When a size other than “A3,” “B4,” “A4,” “B5,” “8.5 x 11 in.,” “11 x 17 in.,” “16K (267 x 194mm) / 8K (267 x 388mm),” and “16K (270 x 195mm) / 8K (270 x 390mm)” is selected
- When a setting other than “None” or “On (Mixed Sizes)” is selected for “Hole Punching” in the “Paper / Output” tab

Hole Punching

Select the punching position. The holes are made based on the output orientation of the paper. As a result, the holes may not be punched correctly depending on the position of the image.

Note

Moreover, there are limitations for punching holes on mixed size output. Hole punching for mixed size output is not available in the following situations:

- When a setting other than “1 Up” is selected for “Multiple-Up” in the “Layout” tab
- When a setting other than “Off” is selected for “Booklet Creation” in the “Layout” tab
- When “Double Print” is set to “On” under “Details” in the “Detailed Settings” tab
- When a size other than “A3,” “B4,” “A4,” “B5,” “8.5 x 11 in.,” “11 x 17 in.,” “16K (267 x 194mm) / 8K (267 x 388mm),” and “16K (270 x 195mm) / 8K (270 x 390mm)” is selected
- When a setting other than “None,” “1 Staple (Mixed Sizes),” or “2 Staples (Mixed Sizes)” is selected for “Stapling” in the “Paper / Output” tab

Hole Punching - Specify the number of holes to punch. Select from Use Printer Settings, 2 Holes, or 4 Holes.

Note

If 3 Holes is selected for Hole Puncher Setup on the Device Settings tab, only Use Printer Settings will be available for selection. Device Settings tab is displayed on the print driver screen when Properties is selected from the menu of the printer icon in the Printers folder.
Stapling/Hole Punching for Mixed Size Output

Click this button to display the Stapling/Hole Punching for Mixed Size Output dialog box. You can specify the settings for stapling or punching for mixed sized documents.

Note
There are limitations for stapling mixed size output. Stapling for mixed size output is not available in the following situations:

- When a setting other than 1 Up is selected for Multiple-Up in the Layout tab
- When a setting other than Off is selected for Print Booklet in the Layout tab
- When Double Print is set to On under Details in the Detailed Settings tab
- When a size other than "A3," "B4," "A4," "B5," "8.5 x 11 in.," "11 x 17 in.," "16K (267 x 194mm) / 8K (267 x 388mm)," and "16K (270 x 195mm) / 8K (270 x 390mm)" is selected
- When a setting other than None or On (Mixed Sizes) is selected for Hole Punching in the Paper / Output tab
- When a setting other than None, 1 Staple (Mixed Sizes), or 2 Staples (Mixed Sizes) is selected for Stapling in the Paper / Output tab
  - Stapling - Specify the position to staple mixed size originals. Select 1 Staple (Mixed Sizes) or 2 Staples (Mixed Sizes).

Key Point
If Double Print is set to On under Details in the Detailed Settings tab, the Stapling feature will not be available.

- Hole Punching - Select On (Mixed Sizes) to enable hole punching feature for mixed size originals.

Key Point
When Double Print is set to On under Details in the Detailed Settings tab, Hole Punching feature will not be available.

- Hole Punching - Specify the number of holes to punch. Select from Use Printer Settings, 2 Holes or 4 Holes.

Note
If 3 Holes is selected in Hole Punching Settings on the Device Settings tab, only Use Printer Settings will be available for selection.

Folding (Z Folding)

If Tri-Fold Output Tray is installed, select the check box to perform Z folding for Mixed Size Documents.

- Image Rotation (180deg) - Turn the mixed size originals by 180 degrees and print.
- Select Portrait, Landscape, or Portrait & Landscape (For envelopes).
- If 2 Up or more is selected in Multiple-Up on the Layout tab, individual pages will be rotated and printed.
- First Page - Specifies the Paper Size and Image Orientation of the first page of the mixed size document.
  - Paper Size (First Page) - Specifies the paper size of the first page of the document.

The paper size combinations for mixed size originals are "A3 and A4," "B4 and B5," "8.5 x 11 in. and 11 x 17 in. and "16K and 8K." Paper Size of the Mixed Pages will
automatically be specified based on this setting.

- **Image Orientation (First Page)** - Specifies the image orientation of the first page of the document.
  
  Select either **Portrait** or **Landscape**.

- **Mixed Pages** - Specifies the **Paper Size** and **Image Orientation** of the mixed pages.
  
  - **Paper Size (Mixed Pages)** - Displays the paper size of the mixed pages.
    
    The paper size will automatically be specified based on the **Paper Size** settings of the first page.
  
  - **Image Orientation (Mixed Pages)** - Specifies the image orientation of the mixed pages.
    
    Select either **Portrait** or **Landscape**.

**Folding**

Select the folding method.

**Note**

“Z Fold”, “Z Tri-Fold,” and “C Tri-Fold” will be available when the Tri-Fold Output Tray is installed and set up in the **Device Settings** tab.

**Note**

**Bi-Fold** is available when a Booklet Tray is installed and set up in the **Device Settings** tab.

**Output Destination**

Select the paper output destination. Select **Auto Select** or **Finisher Tray (Large Output)** from the **Output Destination** menu.

**Printer Status**

Open the Web browser and connect to CentreWare Internet Services for the printer to display the printer status.

To use CentreWare Internet Services, you must set the Internet Services on the printer to **Start**.
Layout tab

![Layout tab settings](image)

Note
You can restore defaults by clicking Restore Defaults.

Settings:

Multi-Up

Prints 2, 4, 6, 9 or 16 consecutive pages of the document on a single page of paper. This feature is known as Multiple-Up.

Select the number of pages to be printed on a single page from "2 Up," "4 Up," "6 Up," "9 Up," and "16 Up." The area of the paper to be printed is divided equally among the pages and the pages will be automatically rotated and reduced to fit into the page.

Key Point
If setting other than Off is selected in Booklet Creation on the Layout tab, only 1 Up can be selected. You can check the result of the change in setting on the preview image at the top right of the screen.

Image Border

Select this check box to add a border around every page of the original document when printed in Multiple-Up layout.

Print Booklet

Specify the assembling and finishing methods for booklet creation. You can check the result of the change in setting on the preview image at the top right of the screen.

Key Point
Booklet Creation feature will only be available if Automatically Select or Auto Paper Select (Type) is selected in Paper Source on the Paper / Output tab.

Output Size for Booklet
Specify the output size for booklet creation printing.

Note
When Booklet Creation is selected, only AutoSelect Tray and Auto Paper Select (Type) are available in Paper Source on the Paper / Output tab. Conversely, Booklet Creation feature is only available when Automatically Select or Auto Paper Select (Type) is selected in Paper Source.

Booklet Subsets

Specify the number of sheets in each subset when printing booklet in subsets. Select from None, or Every Sheet to Every 20 Sheets.

Gutter

Select this box to add a Gutter Margin.

Margin Shift

Clicking this button displays the Margins dialog box. Enter the position and the extent of the margin shift on the paper.

- **Position** - Specifies the margin shift (binding margin) position. The margin can be added to the left, right, top, or bottom of the paper. The margin positions change according to the paper orientation.

  Key Point
  If setting other than Off is selected in Print Booklet on the Layout tab, only No Shift will be available in Position.

- **Side 1** - Specifies the margin on side 1 of the paper when using the Margin Shift function. You can specify any value between 0 and 50 mm in units of 1mm using the keyboard or the up and down arrows.

- **Side 2** - Specifies the margin on side 2 of the paper when using the Margin Shift function in 2-sided printing.
  - The margin shift position for side 2 is automatically set so that the margin is added to the same edge as side 1.
  - You can specify any value between 0 and 50 mm in units of 1mm using the keyboard or the up and down arrows.

Printer Status

Open a Web browser and connect to CentreWare Internet Services for the printer to display the printer status.

To use CentreWare Internet Services, you must set the Internet Services on the printer to **Start**.

Note
This feature cannot be used when the printer is used as a local printer.
Macintosh computers

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens displayed on your 4112/4127 system. The UI screens vary from system to system and from marketplace to marketplace. Therefore, the UI screens in this guide are a representation of the type of screens that may be seen on your particular system.

About the software

This section describes the Macintosh software that is included on the PostScript Driver Library CD-ROM.

Note
When using AppleTalk protocol to print from Macintosh, set the EtherTalk port to Enable on the Control Panel.

Bundled software

Insert the CD-ROM and double-click the Adobe icon to display the window. The following items are contained in the folder:

**AdobePS Printer Driver (ver. 8.5.1, 8.7.0, and 8.8) and PPD files**
Adobe PostScript driver and PPD files (for Macintosh).

**Xerox PPD Installer**
The PPD file installer for Mac OS X, 10.3.

**Xerox PS Utility**
Enables you to define your printer settings.

**Adobe Screen Fonts**
Contains 117 PostScript fonts and 19 TrueType fonts, which are standard for PostScript 3 printers. In addition, 37 PostScript fonts for the Central European (CE) character set are included.

**ATM (Adobe Type Manager) (ver. 4.5.2)**
Helps you to install typefaces and activate and manage your fonts.
Adobe Acrobat Reader

Allows you to view and print PDF files on all major computing platforms.

Readme.txt

Contains cautionary notes about how to use the printer driver. Ensure you read this before use.

Hardware/software requirements

The minimum system requirements for the Macintosh printer driver and the utility are described below.

Computer system

- Macintosh
- Power Macintosh

Basic software

- For PPD Installer - Mac OS X 10.3.3 or later
- For Xerox PS Utility - Mac OS 10.3 or later

Note

When using Mac OS X, launch the Classic environment to run the applications.

AdobePS Printer Driver

Tip

When installing the printer driver, ensure that you select the correct one (4112/4127).

There are two steps to install the printer driver. Firstly, use the installer enclosed on the CD-ROM to install the printer to the Macintosh. Then, configure the printer driver according to the printer used.
Installation procedure (Mac OS X)

Use the following procedure to install the PostScript Printer Description (PPD) file for your Macintosh computer. The Mac OS (operating system) X version 10.3.x is used as the example throughout this procedure.

Note
The printer driver does not need to be installed on the Mac OS X. It uses the Adobe PostScript driver that is provided with the operating system.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive. The PS icon appears on the desktop.
2. Double-click PS. The PS window opens.
3. Open the Mac folder.
4. Open the Mac OS X folder. The Mac OS X window opens.
5. Double-click Xerox PPD Installer. The installer starts and the Authenticate window opens.
6. Enter the Administrator user name and password, then click OK.

The License screen opens.

7. Read through the license agreement carefully and, if you have no objections to it, click Accept.

Note
The printer driver does not need to be installed on the Mac OS X. It uses the Adobe PostScript driver that is provided with the operating system.
8. Confirm the Install Location and change it if necessary, then click **Install**.

![Xerox PPD Installer](image)

9. Click **Quit**.

   ![No installation was necessary](image)

This completes the installation.

Proceed to “Adding a Printer (Mac OS X)” to continue.

### Adding a Printer (Mac OS X)

After the PPD file has been installed, set the PPD file for the printer driver and then add the printer. The printer driver controls the printer functions based on the information in the PPD file. Use the following procedure to add a printer. This procedure uses Macintosh OS X v10.2.8 as its example.

**Note**

Menu items and procedures may vary slightly for Mac OS X v10.3.3 or other operating system versions.

1. Check that the port on the Xerox 4112/4127 Copier / Printer is set to Enable.
   - When using AppleTalk, set the EtherTalk port to Enable.
   - When using IP Printing, set the LPD port to Enable.

   You can check the EtherTalk and LPD settings in the System Settings List. See the User Guide for details about how to print the “System Settings List.”

2. Start [Print Center].

   **Note**

   You can find Print Center in the Utilities folder in the Applications folder. For Mac OS X 10.3.3, open the Printer Setup Utility in the Utilities folder in the Applications folder.

   The Printer List screen opens.
3. Click Add.

4. Select the protocol used to connect the printer.

When using Apple Talk
5. Select Apple Talk from the menu, and specify the zone for the printer being used.

6. Select the printer you are using from the list.
7. Select Auto Select from Printer Model.
8. Click Add.
   After clicking Add, a message may appear telling you that multiple printer files were found. Select the PPD file you will use and click Add.

When using IP Printing
9. Select IP Printing from the menu, and enter the IP address for the printer being used in Printer's Address.
   Note
   For Mac OS X v10.3.3, select LPD/LPR for printer type.

10. Select Xerox 4112/4127 PS from Printer Model, and select the printer to be used.
11. Click Add.
Printer options

1. Click **Printers** on the Print Center menu bar, and select **Show Info**, or
   For Mac OS X v10.3.3, click [Printers] on the Printer Set up Utility menu bar, then select **Show Info**.

2. Select **Installable Options**, and select the options that have been installed on the printer.
   See “Printer options” on page 6, for details about the options.

Note
This section describes the Configure dialog in the Chooser and the Printer Specific Options of the printer driver.

**For Mac OS X**

1. Click **Printers** on the Print Center menu bar, and select **Show Info**.
   For Mac OS X v10.3.3, click [Printers] on the Printer Setup Utility menu bar, then select **Show Info**.

2. Select **Installable Options**, and select the options that have been installed on the printer.

Settings:

**Hole Puncher Setup**

Specify the number of holes to punch on the paper. Select from "2 Holes/4 Holes" or "3 Holes."

**High Capacity Feeder**

Select "Available" if the High Capacity Feeder has been installed.

**Tri-Folding Output Tray**

Select "Available" if the Tri-Fold Output Tray is installed.

**Booklet Output Tray**

Select "Available" if the Booklet Tray is installed.

**Memory**

The built-in memory is 512MB.
Paper Size Settings

Specify the paper size group for different locales to enable the selection of paper sizes common to that locale. The following groups of paper size categorized by locale are available: “AB Series,” “AB Series (8K/16K),” “AB Series (8 x 13),” “AB Series (8 x 13’/8 x 14’),” and “Inch Series.” As the paper size settings will be set automatically in accordance with the relevant locale, it is usually not necessary to change this setting.

Switch Paper Size (8K/16K)

Indicate your language preference to enable the set of 8K and 16K paper sizes that is best suited to your needs. If you select “Traditional Chinese,” the dimensions of the 8K and 16K paper sizes are 267 x 388mm and 194 x 267mm respectively. If you select “Simplified Chinese,” the dimensions will be 270 x 390mm and 195 x 270mm respectively.

Note
If “AB Series (8K/16K)” is not selected in “Paper Size Settings,” both sets of 8K and 16K paper sizes will not be available despite the setting specified here.

Printer features

For Mac OS X

1. On the File menu of the current application, click Print.
   The Print dialog box appears.
2. Select Printer Features.
3. Specify the functions that you want to set.

Settings:

The settings that can be selected vary depending on which options have been installed. Make these settings after specifying the installed options in Configure. See “Printer Options”.

Offset Stacking

The position of individual jobs or sets of copies are shifted to either side of the output tray to enable easy separation.

Collated

Selects whether to collate a multiple-page file per set when they are printed.

Feed Separators from

Specifies the paper tray that transparency dividers are to be fed from. When [Auto] is selected, the tray set on the machine is used as the feed destination.

Print on Separators

Specifies whether or not to print on the transparency dividers as well as the transparency.

Front Cover

Specify whether to add front cover to the printouts. Select the paper tray for feeding the front cover sheets.

Back Cover

Specify whether to add back cover to the printouts. Select the paper tray for feeding the back cover sheets.

Tray 8 · Specify Tab Stock

Specifies whether tab stock is being loaded in tray 8. Select either “Plain” or “Tab Stock.”

Stapling

Specifies whether or not to staple printed documents and the position of the staple. You can staple 2 to 50 sheets of 80 gsm or lighter paper.
Hole Punching

Select the punching position. The holes are made based on the output orientation of the paper. As a result, the holes may not be punched correctly depending on the position of the image.

Hole Punching

Specify the number of holes to punch. Select from "Use Printer Settings," "2 Holes," or "4 Holes." If "3 Holes" is selected for "Hole Puncher Setup," only "Use Printer Settings" will be available for selection.

Folding

Select the folding method.

Double Print

Enable this feature to repeatedly print one page twice on a paper with a bigger size than the original. You can use Double Print feature if you have set the zoom ratio to 100% with the following paper size and output size settings.

- Paper Size
- Output Size
- A4
- A3
- A5
- A4
- B5
- B4
- Folio (8.5 x 11 in.)
- Ledger (11 x 17 in.)

Booklet Creation

Specify the assembling and finishing methods for booklet creation. You can check the result of the change in setting on the preview image at the top right of the screen.

Output Size for Booklet Creation

Specify the output size for booklet creation printing.

Booklet Subsets

Specify the number of sheets in each subset when printing booklet in subsets. Select from "None," or "Every Sheet" to "Every 20 Sheets."

Skip Blank Pages

Specify whether to skip blank pages when printing documents that consist of blank pages.

Bypass Feed Orientation

Specifies the paper orientation when printing from the bypass tray. When feeding the short edge of the paper first, select [Landscape]. When feeding the long edge of the paper, select [Portrait].
Paper Type/Media

Select the paper type to be used for printing.

Output Destination

Select the paper output destination.

Print Mode

Specifies whether to give priority to the print speed or the image quality.

Halftone

Select the halftone settings for printing.
- Select Fine Dots for the small size halftone dot commonly used in PostScript.
- Select Thick Dots for coarser dots than the Fine Dots setting.
- Select Type 3 for the same halftone setting that is used in PCL.

Image Enhancement

Specifies whether or not to use the Image Enhancement function. Selecting On smooths out boundaries when printing. This reduces jagged edges by artificially increasing the resolution of the image. When printing a bitmapped image composed of coarse halftone dots, smooth color or grayscale gradation is impossible in certain situations. In this case, select Off.

Draft Mode

Specifies whether or not to reduce the amount of toner used when printing drafts. When On is selected, the overall printed page becomes lighter. This is best for printing documents when high print quality is not necessary.

Custom Paper Auto Orientation

Specifies whether or not to correct the orientation of the custom paper.

Substitute Tray

Specifies what action to take when the paper for the print size is not loaded in the machine.
- Use Printer Settings - Use the printer settings. The settings can be confirmed on the control panel.
- Display Message - Display paper supply messages on the control panel. Printing is impossible until paper is supplied.
- Use Nearest Size (Adjust to Fit) - Selects the nearest paper size and automatically adjusts the image size as necessary.
- Use Nearest Size (No Zoom) - Selects the nearest paper size and prints the same size as the image.
- Use Larger Size (Adjust to Fit) - Selects paper larger than the original and automatically adjusts the image size as necessary.
- Use Larger Size (No Zoom) - Selects paper larger than the original and prints the same size as the image.
- Feed from Bypass Tray - Feed from bypass tray.
Print Mixed Size Originals

Controls the orientation of the second-side image when printing double-sided.

Job Type (Mac OS X only)

1. On the File menu of the current application, click **Print**. The Print dialog box appears.
2. Select **Job Type**.
3. Specify the functions that you want to set.
Settings:

Job Type

You can specify the print function for Secure Print, Sample Print, and Delayed Print.

- **Secure Print** temporarily stores print jobs in the printer, and then prints them when print instructions are received from the control panel.

- **Sample Print** outputs only one copy when multiple copies are specified. If there is no problem, the remaining sets can be printed.

- **Delayed Print** temporarily stores print jobs in the printer, and then prints them at the scheduled time.

To use the Secure Print or Sample Print feature, input the User ID and password for Print Type. The password entered appears as bullets (●).

- **Normal Print** - Select when you do not want to output secure prints, sample prints, or delayed prints.

- **Secure Print** - Select when you want to output secure prints.

- **Sample Print** - Select when you want to output sample prints.

- **Delayed Print** - Select when you want to output delayed prints.

See the Online Help for details on the operation of the printer.

User ID

Enter the User ID for Secure Print or Sample Print.

Password

Enter the password for Secure Print. Each digit entered appears as a bullet (●).

Retrieve Document Name

Select the method for specifying the document name. If you have selected Auto Retrieve, the valid document name can be up to 24 alphanumeric characters.

Document Name

When "Enter Document Name" is selected in the Retrieve Document Name list, a document name up to 24 alphanumeric characters can be specified.

Start Print Time

Specifies the time when a Delayed Print job will be printed. Place the cursor in the hour or minute box and press the up or down triangle to specify the start time. You can also set the time by entering the time directly into the boxes. The default setting is 00:00.
Job Accounting (Mac OS X only)

1. On the File menu of the current application, click [Print]. The Print dialog box appears.

2. Select **Job Accounting**.

3. Specify the functions that you want to set.
Settings:

Account Mode

Specifies if all users or only System Administrators can change authentication related settings.

Detailed User Settings

Opens the Detailed User Settings dialog box used to set the authentication information.

Use Default User Details - The values set in this feature are used as the authentication parameters.

- Specify Job Owner Name - Select how to specify User ID.
- Job Owner Name - Enter a User ID.
- Password - Enter a Password that matches the User ID. The password entered appears as bullets (●).
- Account ID - Enter an Account ID.
- Billing ID - Enter a User ID for Charge Print.
- Password - Enter a Password that matches the Billing ID. The password entered appears as bullets (●).
- Prompt User for Settings - Select this feature to display the [Enter User Details] dialog box each time you start printing. The user is then required to enter authentication information such as their User ID.
- Display Previous User Details - Select the check box to store the user details entered in the [Enter User Details] dialog box, and display the details in the box as a default next time.
- Hide User ID - Select the check box to specify whether a user ID is to be displayed or hidden when it is entered.
- Hide Account ID - Select the check box to specify whether an account ID is to be displayed or hidden when it is entered.
Installing screen fonts

Key Point
It is recommended that all other applications are closed before installing the fonts. If applications are not closed, a warning message appears between Step 5 and Step 6.

1. Start Macintosh and insert the PostScript Driver Library CD-ROM into the CD-ROM drive.
2. Double-click the PS icon followed by the Screen Font folder and then the PS3 Fonts Installer. The following window appears:

   ![Adobe PostScript 3 Font Installer](image)

3. Click Continue.
The license agreement dialog appears.

4. Read through the agreement carefully and if you have no objections to it, click Accept.

   ![License Agreement](image)

The PS3FontsInstaller dialog box appears.
5. You may select **Easy Install** or **Custom Install**.
   - **Easy Install** - installs all the fonts provided in the Screen Font folder.
   - **Custom Install** - installs the selected fonts only. Click on the triangle arrow beside the four categories of fonts to display the fonts in each category and then check the fonts to be installed. For example, the diagram below shows that Arial CE of the CE TrueType fonts is selected.

   ![Easy Install Diagram](image)

   ![Custom Install Diagram](image)

   A warning message will appear if you did not quit all other applications before performing the font installation.

6. Click **Install**.
   - The installation of the fonts begins.
   - After the installation, you have to restart your Macintosh before the fonts can be used.
   - Store your CD-ROM in a safe place.
## Barcode Settings

### Key Point

The User Interface (UI) screens shown in this guide may or may not reflect the screens displayed on your 4112/4127 system. The UI screens vary from system to system and from marketplace to marketplace. Therefore, the UI screens in this guide are a representation of the type of screens that may be seen on your particular system.

### About barcode settings

#### Note

This guide assumes that the operator has a basic knowledge of barcodes.

### Font types and character sets

For the character set used to specify each barcode character, see **Character set tables**. See **Barcode sizes** for details about the size of printed barcode.

The table below lists compatible barcode types.

<table>
<thead>
<tr>
<th>Barcode type</th>
<th>PostScript font name</th>
<th>Refer to the following table</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAN</td>
<td>HitachiITHINJANH8-RG</td>
<td>JAN Character Set Table</td>
</tr>
<tr>
<td>Code 39</td>
<td>HitachiIT-C39H8</td>
<td>Code 39 Character Set Table</td>
</tr>
<tr>
<td>NW7</td>
<td>HitachiITHINNW7H8-RG</td>
<td>NW7 Character Set Table</td>
</tr>
<tr>
<td>Code 128</td>
<td>HitachiITHINC128H8-RG</td>
<td>Code 128 Character Set Table</td>
</tr>
<tr>
<td>ITF (without bearer bar)</td>
<td>HitachiITHINITFH8-RG</td>
<td>ITF (Interleaved 2 of 5) Character Set Table</td>
</tr>
<tr>
<td>ITF (with bearer bar)</td>
<td>HitachiITHINITFB-RG</td>
<td></td>
</tr>
<tr>
<td>Customer Barcode</td>
<td>HitachiITHINPOSTBC-RG</td>
<td>Customer Barcode Character Set Table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Font type</th>
<th>PostScript font name</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCR B LetterPress M</td>
<td>OCRBLetM</td>
</tr>
</tbody>
</table>
Note
The printed barcode's readability depends largely on factors such as the quality of paper used and performance of the barcode reader. Before using this product, we recommend you thoroughly test it under the conditions in which it will be used.

Sample program and output results

A program that prints a sample of each type of barcode and a PDF showing the output results is provided. Use these samples as a reference when printing barcodes.

- Location of sample program and output results in PDF
  Located in the [manual] > [sample] folder on the PostScript Driver Library CD-ROM
- Sample program name
  Sample.ps
- Output results PDF name
  Sample.pdf

Character set tables

JAN character set table

The table below lists the character sets used when printing JAN barcode characters.
Code 39 character set table

The table below lists the character sets used when printing Code 39 barcode characters.

<table>
<thead>
<tr>
<th>Character</th>
<th>Character set</th>
<th>Character</th>
<th>Character set</th>
<th>Character</th>
<th>Character set</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left side odd parity</td>
<td></td>
<td>Left side even parity</td>
<td></td>
<td>Right side even parity</td>
</tr>
<tr>
<td></td>
<td>HEX notation</td>
<td>ASCII notation</td>
<td>HEX notation</td>
<td>ASCII notation</td>
<td>HEX notation</td>
</tr>
<tr>
<td>$</td>
<td>24 $</td>
<td>8</td>
<td>38 8</td>
<td>M</td>
<td>4D M</td>
</tr>
<tr>
<td>%</td>
<td>25 %</td>
<td>9</td>
<td>39 9</td>
<td>N</td>
<td>4E N</td>
</tr>
<tr>
<td>*</td>
<td>2A *</td>
<td>(SP) 20</td>
<td>SP O</td>
<td>4F O</td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>2B +</td>
<td>A 41 A</td>
<td>P 50 P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>2D -</td>
<td>B 42 B</td>
<td>Q 51 Q</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.</td>
<td>2E .</td>
<td>C 43 C</td>
<td>R 52 R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>/</td>
<td>2F /</td>
<td>D 44 D</td>
<td>S 53 S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>30 0</td>
<td>E 45 E</td>
<td>T 54 T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>31 1</td>
<td>F 46 F</td>
<td>U 55 U</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>32 2</td>
<td>G 47 G</td>
<td>V 56 V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>33 3</td>
<td>H 48 H</td>
<td>W 57 W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>34 4</td>
<td>I 49 I</td>
<td>X 58 X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>35 5</td>
<td>J 4A J</td>
<td>Y 59 Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>36 6</td>
<td>K 4B K</td>
<td>Z 5A Z</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>37 7</td>
<td>L 4C L</td>
<td>(SP) 40 @</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## NW7 character set table

The table below lists the character sets used when printing NW7 barcode characters.

<table>
<thead>
<tr>
<th>Character</th>
<th>Character set</th>
<th></th>
<th>Character</th>
<th>Character set</th>
<th></th>
<th>Character</th>
<th>Character set</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>24</td>
<td>$</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>A</td>
<td>41</td>
</tr>
<tr>
<td>+</td>
<td>2B</td>
<td>+</td>
<td>1</td>
<td>31</td>
<td>1</td>
<td>B</td>
<td>42</td>
</tr>
<tr>
<td>-</td>
<td>2D</td>
<td>-</td>
<td>2</td>
<td>32</td>
<td>2</td>
<td>C</td>
<td>43</td>
</tr>
<tr>
<td>.</td>
<td>2E</td>
<td>.</td>
<td>3</td>
<td>33</td>
<td>3</td>
<td>D</td>
<td>44</td>
</tr>
<tr>
<td>/</td>
<td>2F</td>
<td>/</td>
<td>4</td>
<td>34</td>
<td>4</td>
<td>A</td>
<td>61</td>
</tr>
<tr>
<td>5</td>
<td>35</td>
<td>5</td>
<td>B</td>
<td>62</td>
<td>B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>36</td>
<td>6</td>
<td>C</td>
<td>63</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>37</td>
<td>7</td>
<td>D</td>
<td>64</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>38</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>39</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>:</td>
<td>3A</td>
<td>:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Code 128 character set table

The table below lists the character sets used when printing Code 128 barcode characters.

<table>
<thead>
<tr>
<th>Value</th>
<th>Character set</th>
<th></th>
<th>Character set</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>SP</td>
<td>1</td>
<td>SP</td>
<td>SP</td>
</tr>
<tr>
<td>1</td>
<td>!</td>
<td>2</td>
<td>21</td>
<td>!</td>
</tr>
<tr>
<td>2</td>
<td>&quot;</td>
<td>3</td>
<td>22</td>
<td>&quot;</td>
</tr>
<tr>
<td>3</td>
<td>#</td>
<td>4</td>
<td>23</td>
<td>#</td>
</tr>
<tr>
<td>4</td>
<td>$</td>
<td>5</td>
<td>24</td>
<td>$</td>
</tr>
<tr>
<td>5</td>
<td>%</td>
<td>6</td>
<td>25</td>
<td>%</td>
</tr>
<tr>
<td>6</td>
<td>&amp;</td>
<td>7</td>
<td>26</td>
<td>&amp;</td>
</tr>
<tr>
<td>7</td>
<td>`</td>
<td>8</td>
<td>27</td>
<td>`</td>
</tr>
<tr>
<td>8</td>
<td>(</td>
<td>9</td>
<td>28</td>
<td>(</td>
</tr>
<tr>
<td>9</td>
<td>)</td>
<td>10</td>
<td>29</td>
<td>)</td>
</tr>
<tr>
<td>10</td>
<td>*</td>
<td>11</td>
<td>2A</td>
<td>*</td>
</tr>
<tr>
<td>11</td>
<td>+</td>
<td></td>
<td>2B</td>
<td>+</td>
</tr>
<tr>
<td>Value</td>
<td>Character</td>
<td>Character set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>---------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CODE A</td>
<td>CODE B</td>
<td>CODE C</td>
<td>HEX notation</td>
</tr>
<tr>
<td>12</td>
<td>.</td>
<td>.</td>
<td>12</td>
<td>2C</td>
</tr>
<tr>
<td>13</td>
<td>-</td>
<td>-</td>
<td>13</td>
<td>2D</td>
</tr>
<tr>
<td>14</td>
<td>.</td>
<td>.</td>
<td>14</td>
<td>2E</td>
</tr>
<tr>
<td>15</td>
<td>/</td>
<td>/</td>
<td>15</td>
<td>2F</td>
</tr>
<tr>
<td>16</td>
<td>0</td>
<td>0</td>
<td>16</td>
<td>30</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>1</td>
<td>17</td>
<td>31</td>
</tr>
<tr>
<td>18</td>
<td>2</td>
<td>2</td>
<td>18</td>
<td>32</td>
</tr>
<tr>
<td>19</td>
<td>3</td>
<td>3</td>
<td>19</td>
<td>33</td>
</tr>
<tr>
<td>20</td>
<td>4</td>
<td>4</td>
<td>20</td>
<td>34</td>
</tr>
<tr>
<td>21</td>
<td>5</td>
<td>5</td>
<td>21</td>
<td>35</td>
</tr>
<tr>
<td>22</td>
<td>6</td>
<td>6</td>
<td>22</td>
<td>36</td>
</tr>
<tr>
<td>23</td>
<td>7</td>
<td>7</td>
<td>23</td>
<td>37</td>
</tr>
<tr>
<td>24</td>
<td>8</td>
<td>8</td>
<td>24</td>
<td>38</td>
</tr>
<tr>
<td>25</td>
<td>9</td>
<td>9</td>
<td>25</td>
<td>39</td>
</tr>
<tr>
<td>26</td>
<td>:</td>
<td>:</td>
<td>26</td>
<td>3A</td>
</tr>
<tr>
<td>27</td>
<td>:</td>
<td>:</td>
<td>27</td>
<td>3B</td>
</tr>
<tr>
<td>28</td>
<td>&lt;</td>
<td>&lt;</td>
<td>28</td>
<td>3C</td>
</tr>
<tr>
<td>29</td>
<td>=</td>
<td>=</td>
<td>29</td>
<td>3D</td>
</tr>
<tr>
<td>30</td>
<td>&gt;</td>
<td>&gt;</td>
<td>30</td>
<td>3E</td>
</tr>
<tr>
<td>31</td>
<td>?</td>
<td>?</td>
<td>31</td>
<td>3F</td>
</tr>
<tr>
<td>32</td>
<td>@</td>
<td>@</td>
<td>32</td>
<td>40</td>
</tr>
<tr>
<td>33</td>
<td>A</td>
<td>A</td>
<td>33</td>
<td>41</td>
</tr>
<tr>
<td>34</td>
<td>B</td>
<td>B</td>
<td>34</td>
<td>42</td>
</tr>
<tr>
<td>35</td>
<td>C</td>
<td>C</td>
<td>35</td>
<td>43</td>
</tr>
<tr>
<td>36</td>
<td>D</td>
<td>D</td>
<td>36</td>
<td>44</td>
</tr>
<tr>
<td>37</td>
<td>E</td>
<td>E</td>
<td>37</td>
<td>45</td>
</tr>
<tr>
<td>38</td>
<td>F</td>
<td>F</td>
<td>38</td>
<td>46</td>
</tr>
<tr>
<td>39</td>
<td>G</td>
<td>G</td>
<td>39</td>
<td>47</td>
</tr>
<tr>
<td>40</td>
<td>H</td>
<td>H</td>
<td>40</td>
<td>48</td>
</tr>
<tr>
<td>41</td>
<td>I</td>
<td>I</td>
<td>41</td>
<td>49</td>
</tr>
<tr>
<td>42</td>
<td>J</td>
<td>J</td>
<td>42</td>
<td>4A</td>
</tr>
<tr>
<td>43</td>
<td>K</td>
<td>K</td>
<td>43</td>
<td>4B</td>
</tr>
<tr>
<td>Value</td>
<td>Character</td>
<td>Character set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>---------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CODE A</td>
<td>CODE B</td>
<td>CODE C</td>
<td>HEX notation</td>
</tr>
<tr>
<td>44</td>
<td>L</td>
<td>L</td>
<td>44</td>
<td>4C</td>
</tr>
<tr>
<td>45</td>
<td>M</td>
<td>M</td>
<td>45</td>
<td>4D</td>
</tr>
<tr>
<td>46</td>
<td>N</td>
<td>N</td>
<td>46</td>
<td>4E</td>
</tr>
<tr>
<td>47</td>
<td>O</td>
<td>O</td>
<td>47</td>
<td>4F</td>
</tr>
<tr>
<td>48</td>
<td>P</td>
<td>P</td>
<td>48</td>
<td>50</td>
</tr>
<tr>
<td>49</td>
<td>Q</td>
<td>Q</td>
<td>49</td>
<td>51</td>
</tr>
<tr>
<td>50</td>
<td>R</td>
<td>R</td>
<td>50</td>
<td>52</td>
</tr>
<tr>
<td>51</td>
<td>S</td>
<td>S</td>
<td>51</td>
<td>53</td>
</tr>
<tr>
<td>52</td>
<td>T</td>
<td>T</td>
<td>52</td>
<td>54</td>
</tr>
<tr>
<td>53</td>
<td>U</td>
<td>U</td>
<td>53</td>
<td>55</td>
</tr>
<tr>
<td>54</td>
<td>V</td>
<td>V</td>
<td>54</td>
<td>56</td>
</tr>
<tr>
<td>55</td>
<td>W</td>
<td>W</td>
<td>55</td>
<td>57</td>
</tr>
<tr>
<td>56</td>
<td>X</td>
<td>X</td>
<td>56</td>
<td>58</td>
</tr>
<tr>
<td>57</td>
<td>Y</td>
<td>Y</td>
<td>57</td>
<td>59</td>
</tr>
<tr>
<td>58</td>
<td>Z</td>
<td>Z</td>
<td>58</td>
<td>5A</td>
</tr>
<tr>
<td>59</td>
<td>[</td>
<td>]</td>
<td>59</td>
<td>5B</td>
</tr>
<tr>
<td>60</td>
<td>\</td>
<td>\</td>
<td>60</td>
<td>5C</td>
</tr>
<tr>
<td>61</td>
<td>]</td>
<td>]</td>
<td>61</td>
<td>5D</td>
</tr>
<tr>
<td>62</td>
<td>`</td>
<td>`</td>
<td>62</td>
<td>5E</td>
</tr>
<tr>
<td>63</td>
<td>_</td>
<td>_</td>
<td>63</td>
<td>5F</td>
</tr>
<tr>
<td>64</td>
<td>NUL</td>
<td>`</td>
<td>64</td>
<td>60</td>
</tr>
<tr>
<td>65</td>
<td>SOH</td>
<td>a</td>
<td>65</td>
<td>61</td>
</tr>
<tr>
<td>66</td>
<td>STX</td>
<td>b</td>
<td>66</td>
<td>62</td>
</tr>
<tr>
<td>67</td>
<td>ETX</td>
<td>c</td>
<td>67</td>
<td>63</td>
</tr>
<tr>
<td>68</td>
<td>EOT</td>
<td>d</td>
<td>68</td>
<td>64</td>
</tr>
<tr>
<td>69</td>
<td>ENQ</td>
<td>e</td>
<td>69</td>
<td>65</td>
</tr>
<tr>
<td>70</td>
<td>ACK</td>
<td>f</td>
<td>70</td>
<td>66</td>
</tr>
<tr>
<td>71</td>
<td>BEL</td>
<td>g</td>
<td>71</td>
<td>67</td>
</tr>
<tr>
<td>72</td>
<td>BS</td>
<td>h</td>
<td>72</td>
<td>68</td>
</tr>
<tr>
<td>73</td>
<td>HT</td>
<td>I</td>
<td>73</td>
<td>69</td>
</tr>
<tr>
<td>74</td>
<td>LF</td>
<td>j</td>
<td>74</td>
<td>6A</td>
</tr>
<tr>
<td>75</td>
<td>VT</td>
<td>k</td>
<td>75</td>
<td>6B</td>
</tr>
<tr>
<td>Value</td>
<td>Character set</td>
<td>Character</td>
<td>CODE A</td>
<td>CODE B</td>
</tr>
<tr>
<td>-------</td>
<td>--------------</td>
<td>-----------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>76</td>
<td></td>
<td>FF</td>
<td>l</td>
<td></td>
</tr>
<tr>
<td>77</td>
<td></td>
<td>CR</td>
<td>m</td>
<td></td>
</tr>
<tr>
<td>78</td>
<td></td>
<td>SO</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>79</td>
<td></td>
<td>SI</td>
<td>o</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td>DLE</td>
<td>p</td>
<td></td>
</tr>
<tr>
<td>81</td>
<td></td>
<td>DC1</td>
<td>q</td>
<td></td>
</tr>
<tr>
<td>82</td>
<td></td>
<td>DC2</td>
<td>r</td>
<td></td>
</tr>
<tr>
<td>83</td>
<td></td>
<td>DC3</td>
<td>s</td>
<td></td>
</tr>
<tr>
<td>84</td>
<td></td>
<td>DC4</td>
<td>t</td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td>NAK</td>
<td>u</td>
<td></td>
</tr>
<tr>
<td>86</td>
<td></td>
<td>SYN</td>
<td>v</td>
<td></td>
</tr>
<tr>
<td>87</td>
<td></td>
<td>ETB</td>
<td>w</td>
<td></td>
</tr>
<tr>
<td>88</td>
<td></td>
<td>CAN</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td></td>
<td>EM</td>
<td>y</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td>SUB</td>
<td>z</td>
<td></td>
</tr>
<tr>
<td>91</td>
<td></td>
<td>ESC</td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>92</td>
<td></td>
<td>FS</td>
<td>l</td>
<td></td>
</tr>
<tr>
<td>93</td>
<td></td>
<td>GS</td>
<td>)</td>
<td></td>
</tr>
<tr>
<td>94</td>
<td></td>
<td>RS</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td>US</td>
<td>DEL</td>
<td></td>
</tr>
<tr>
<td>96</td>
<td></td>
<td>FNC 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97</td>
<td></td>
<td>FNC 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>98</td>
<td></td>
<td>SHIFT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>99</td>
<td></td>
<td>CODE C</td>
<td>CODE C</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td>CODE B</td>
<td>FNC 4</td>
<td>CODE B</td>
</tr>
<tr>
<td>101</td>
<td></td>
<td>FNC 4</td>
<td>CODE A</td>
<td>CODE A</td>
</tr>
<tr>
<td>102</td>
<td></td>
<td>FNC 1</td>
<td>FNC 1</td>
<td></td>
</tr>
<tr>
<td>103</td>
<td></td>
<td>START(CODE A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>104</td>
<td></td>
<td>START(CODE B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>105</td>
<td></td>
<td>START(CODE C)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>106</td>
<td></td>
<td>STOP</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### ITF (Interleaved 2 of 5) character set table

The table below lists the character sets used when printing ITF barcode characters.

<table>
<thead>
<tr>
<th>Character</th>
<th>Character set</th>
<th>Character set</th>
<th>Character set</th>
<th>Character set</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>21 !</td>
<td>30 3F ?</td>
<td>60 5D ]</td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>22 *</td>
<td>31 40 @</td>
<td>61 5E ^</td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>23 #</td>
<td>32 41 A</td>
<td>62 5F _</td>
<td></td>
</tr>
<tr>
<td>03</td>
<td>24 $</td>
<td>33 42 B</td>
<td>63 60 `</td>
<td></td>
</tr>
<tr>
<td>04</td>
<td>25 %</td>
<td>34 43 C</td>
<td>64 61 a</td>
<td></td>
</tr>
<tr>
<td>05</td>
<td>26 &amp;</td>
<td>35 44 D</td>
<td>65 62 b</td>
<td></td>
</tr>
<tr>
<td>06</td>
<td>27 '</td>
<td>36 45 E</td>
<td>66 63 c</td>
<td></td>
</tr>
<tr>
<td>07</td>
<td>28 (</td>
<td>37 46 F</td>
<td>67 64 d</td>
<td></td>
</tr>
<tr>
<td>08</td>
<td>29 )</td>
<td>38 47 G</td>
<td>68 65 E</td>
<td></td>
</tr>
<tr>
<td>09</td>
<td>2A *</td>
<td>39 48 H</td>
<td>69 66 F</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2B +</td>
<td>40 49 I</td>
<td>70 67 G</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>2C ,</td>
<td>41 4A J</td>
<td>71 68 H</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>2D -</td>
<td>42 4B K</td>
<td>72 69 I</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>2E .</td>
<td>43 4C L</td>
<td>73 6A J</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>2F /</td>
<td>44 4D M</td>
<td>74 6B K</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>30 0</td>
<td>45 4E N</td>
<td>75 6C L</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>31 1</td>
<td>46 4F O</td>
<td>76 6D M</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>32 2</td>
<td>47 50 P</td>
<td>77 6E N</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>33 3</td>
<td>48 51 Q</td>
<td>78 6F O</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>34 4</td>
<td>49 52 R</td>
<td>79 70 P</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>35 5</td>
<td>50 53 S</td>
<td>80 71 Q</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>36 6</td>
<td>51 54 T</td>
<td>81 72 R</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>37 7</td>
<td>52 55 U</td>
<td>82 73 S</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>38 8</td>
<td>53 56 V</td>
<td>83 74 T</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>39 9</td>
<td>54 57 W</td>
<td>84 75 U</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>3A :</td>
<td>55 58 X</td>
<td>85 76 V</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>3B ;</td>
<td>56 59 Y</td>
<td>86 77 W</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>3C &lt;</td>
<td>57 5A Z</td>
<td>87 78 X</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>3D =</td>
<td>58 5B [</td>
<td>88 79 Y</td>
<td></td>
</tr>
</tbody>
</table>
With ITF, one character set specifies the pair of a character denoted by a bar and a character denoted by a space. However, the START and the STOP character are specified by one character set.

**Example:**

To print the pair of characters of the bar representing "3" and the space representing "7," specify "46" (HEX notation).

To print the pair of characters of the bar representing "7" and the space representing "3," specify "6A" (HEX notation).

**Customer barcode character set table**

The table below lists the character sets used when printing customer barcode characters.
Barcode sizes

The table below lists formulae for calculating the approximate dimensions of printed barcodes.

The dimensions of the barcode printed may vary, even when using the same program, depending on conditions such as the characteristics and resolution of the printer used, paper quality, and so forth. The dimensions derived from the formulae in this table are not guaranteed to be the actual dimensions of the printed barcodes. Use this table as a reference when estimating the size of printed barcodes.

<table>
<thead>
<tr>
<th>Barcodes type</th>
<th>Formula</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAN (standard)</td>
<td>$P \times 0.502$</td>
<td>$P \times 0.352$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Side margins not included.</td>
<td></td>
<td>Indicates the height of the guard bar.</td>
</tr>
<tr>
<td>JAN (short version)</td>
<td>$P \times 0.354$</td>
<td>$P \times 0.352$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Side margins not included.</td>
<td></td>
<td>Indicates the height of the guard bar.</td>
</tr>
<tr>
<td>Code 39</td>
<td>$P \times (C + 2) \times 0.106$</td>
<td>$P \times 0.352$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inter character gap of the left and right sides not included.</td>
<td></td>
<td>“C” includes the checkdigit.</td>
</tr>
<tr>
<td>NW7</td>
<td>$P \times (C1 \times 0.132 + C2 \times 0.148 - 0.026)$</td>
<td>$P \times 0.352$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inter character gap of the left and right sides not included.</td>
<td></td>
<td>“C1” and “C2” include the checkdigit.</td>
</tr>
<tr>
<td>Code 128</td>
<td>$P \times (C \times 0.081 + 0.096)$</td>
<td>$P \times 0.352$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Formula for CODE C.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ITF (without bearer bar)</td>
<td>$P \times ((C/2 \times 0.175) + 0.093)$</td>
<td>$P \times 0.352$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quiet zone not included.</td>
<td></td>
<td>“C” includes the checkdigit.</td>
</tr>
<tr>
<td>ITF (with bearer bar)</td>
<td>$P \times ((C/2 \times 0.137) + 0.323)$</td>
<td>$P \times 0.352$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bearer bar and quiet zone included.</td>
<td></td>
<td>“C” includes the checkdigit.</td>
</tr>
<tr>
<td>Barcodes type</td>
<td>Formula</td>
<td>Width</td>
<td>Height</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td>Customer Barcode</td>
<td>P × 7.297</td>
<td>P × 0.342</td>
<td>Spaces before the black bar of START code and after the black bar of the STOP code are not included.</td>
</tr>
<tr>
<td></td>
<td>Indicating the height of the long bar.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

P: Font size (point)

C: Number of characters

C1: Number of characters (0,1,2,3,4,5,6,7,8,9,\$)

C2: Number of characters (\,\,,+,A,B,C,D)
Appendix

Cautions and limitations

About the driver

Cautions and limitations relating to each type of driver are listed in the Readme.txt file in the PostScript Driver Library CD-ROM. Ensure you read it before installing the driver.

Troubleshooting

See the User Guide for error codes and error messages displayed on the control panel and how to deal with paper jams.

Print operation

The printer driver allows you to make selections to print on custom paper and postcards using duplex and/or the stapling feature to the Finisher Tray. However, if you are printing on custom paper or postcards, these features will not function even though you may still be able to select them.

You can feed custom paper from the bypass tray only. However, when you select custom paper, the Paper Source selection does not change to Manual Feed automatically. Please select Manual Feed yourself.
Index

S
Screen Fonts, 2-1

A
Adobe Acrobat Reader, 2-2
Adobe Type Manager, 2-1
AdobePS Printer Driver (ver. 8.5.1, 8.7.0, and 8.8), 2-1
Advanced Options Dialog Box, 1-13

B
Barcode Settings, 3-1
Barcode Sizes, 3-10

C
Code 128 Character Set Table, 3-4
Code 39 Character Set Table, 3-3
Configuration Tab, 1-11
Customer Barcode Character Set Table, 3-9

E
error codes, A-1
error messages, A-1

J
JAN Character Set Table, 3-2
Job Accounting (Mac OS X only), 2-13
Job Type (Mac OS X only), 2-11

N
NW7 Character Set Table, 3-4

P
PPD, 1-1, 2-1

R
Readme.txt, 1-1, 2-2